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FAMU 4H Tech Changemakers Training

Make an Online Visitor’s Map of Your Campus Using ArcGIS 
Online

Presented by:  Katherine Milla and Sabrina Hayes
3/22/2023

In this training you will learn how to Geographic Information Systems (GIS) 
create an online visitor’s map, using the FAMU campus.  

Here is an example:  FAMU campus visitor’s map

https://famucwq.maps.arcgis.com/apps/instant/basic/index.html?appid=4ebf5b44486c4efc8065ed4a11455f8d
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First, we need to create an account for you on our online GIS portal.

Start by going to www.arcgis.com and click on Sign In

http://www.arcgis.com/
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Click on Create and account.
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Click on Create a public account.
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You will need to provide an email address for your public account.  Once 
you have created the account, I will send you an email to the email 
address of your public account inviting you to joint our FAMU 
organizational account.  This will give you access to a lot more features 
than the public account provides.

Once you have been added to the FAMU organizational account, log in 
using the email and password you used for your public account.
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Let’s take a look around.  Clicking on Home takes you to the overview of the 
main web page.
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The Gallery displays the content that members in the organization have created.  
Most of what you see are maps created by students in previous trainings.
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The Map tab opens a new map template.  Here is where you can create your 
own maps.  We will be using this mapping application to create the map for 
this exercise.
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Click on the “hamburger” icon in the 
upper left corner of the map and 
click Home to get back to the main 
web page.
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The Scene tab opens a basemap layer for creating 3-dimensional maps that 
can be navigated similar to Google Earth.  We won’t use the Scene Viewer for 
this training.  Click the Home tab to return to the main web site.
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From the Home page 
click on the dots icon.  A 
menu opens showing you 
a variety of options.  
These options link to 
different tools and apps 
you can use in ArcGIS 
Online.  Click on the 
StoryMaps icon for an 
example of an ArcGIS 
Online apps.

https://doc.arcgis.com/en/arcgis-
storymaps/gallery/

https://doc.arcgis.com/en/arcgis-storymaps/gallery/
https://doc.arcgis.com/en/arcgis-storymaps/gallery/
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We won’t examine the Notebooks tab in this training.  
Click on the Groups tab.

Groups are subsets of organizational members that are created for group 
members to share content among themselves.  We have created a Group for 
this training.  The Group will remain active for a while after the training is 
complete.
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Click on the 4H Tech Changemakers Group to see the Group contents
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Click on the Content tab.

Under Filters → Group 
Categories, click on Campus 
Photos 
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Make sure the Table view is selected.

You should see 12 files, 11 
photographs (images) and 
one Microsoft Excel file.

You will use these files to 
add content to a new 
Campus Landmark layer 
that you will create and 
add to your map
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1. Create a feature layer for your map.

From the Home page, click on the Content tab.

From your Contents folder click on New Item.  Click on Feature Layer.
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Select Define Your Own Layer and click Next.
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Type in a name for your new layer (the name Campus Landmarks is used for 
this example) and select the type as Point Layer.  Click Next.
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You see that the new 
layer will be stored in 
your Content folder.
Type in 4H Tech 
Changemakers in the 
Tags field, then click 
Save.
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Once you have created the new layer you will see its overview page.  (To get back 
to this page from your Contents page just click on the new layer and this 
overview will open.)  

Click on the layer icon.
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Scroll down and click on the slider button to Enable Attachments.

Click on the Data tab.
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Click on the Fields view tab.

You will see that the table has two fields, OBJECTID and Photos and Files.



The OBJECTID field is created automatically and will assign a record number 
to each point as you create them in the layer.  The Photos and Files layer 
allows you to insert your photos for each landmark directly into the table.

We are going to add two fields to hold the landmark name and address for 
each point.  Click on the Add button
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For the Field Name type  in Name.  The 
Field Name must begin with a letter, can 
only contain letters, numbers, and “-”, 
and cannot have spaces in it.

For the Display Name Type in Landmark 
Name.  The display name, also known as 
an “alias” is what will show in the data 
table column heading and can contain 
spaces.  Use it when you want the 
heading to show something more 
explanatory to your audience about the 
data field.

The field Type is String (text).  For the 
Length type in 75.

Click Add New Field
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The Data View tab appears, and you see your new field with the Display 
Name displayed.

Add another field.
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This field will display the location of the landmark.  Fill in the fields as shown 
below and click Add New Field
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Now you have four fields in your layer, but there are no features in the 
layer yet.  Click on the Overview tab.



Click on Open in Map Viewer
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A window opens showing a map of the world and the layer you just created 
appears in the Layers pane on the left side.  On the right side is the 
Properties panel where you can set different display features for the new 
layer.  Close the Properties panel by clicking on the X.
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On the Layers pane click on the three dots and click on Show Table. 

A table opens displaying the 
fields you just added.  Right 
now, the table is empty.  You 
are going points to the layer 
representing the locations of 
some campus landmarks.

Close the table by clicking on 
the X in the  right corner
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Click on the Search 
(magnifying glass) icon 
in the lower right corner 
of the map.

Type in Florida A&M University and click the 
search icon.
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The map zooms in to the FAMU campus.  Close the popup window by 
clicking on the x in the corner.



Change the basemap to OpenStreetMap and close the Basemap pane by 
clicking on the X.  
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Center the basemap so the Perry-Paige building is approximately in the 
center.
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Make sure the new layer is selected.  To select the layer, make sure the 
Layers pane is open and click on the layer.
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On the right-side vertical 
tool bar Click on the Edit 
tool.
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The Editor pane opens.  The Select tool lets you select features from the 
map for editing.  Right now, there are no features in the layer so we will 
use the New Feature tool to create some.  Click on the New Feature tool.
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With the New Feature tool still selected, move the cursor to the map.  The cursor 
turns to a crosshair centered on the new feature symbol.  The College of 
Agriculture is in the south wing of the Perry-Paige building.  Move the cursor to 
that location and click.  The attribute window for the feature opens and you can 
fill in the Landmark Name and Location from the spreadsheet.  Click the Add 
button to add the photo.
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Click the Select File button.

Navigate to your photos 
folder and double click the 
photos of the building 
entrance.
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You will see your file in the Add Attachment menu.  Click on Add.

Click on Create on the Editor menu to create the new point feature
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Your photo will be added to the Edit panel.
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Click on the Pop-ups tool on the right-side 
menu.  Slide the Enable Pop-ups slider to the 
right.  Click on Add Content and select 
Attachments.

Close the Pop-ups menu by clicking on the X.
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Now you can click on the point and the table information and photo will 
appear in a pop-up window.
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Now that you have created your first 
feature, save your map by clicking on 
the Save and Open tab on the left 
vertical menu.  You see a blue dot next 
to the menu name.  This indicates that 
there are edits that haven’t been saved 
yet.  Select Save As.

If you have not saved the map 
before a menu will open 
prompting you for a title.  Type 
in a title and add a tag as shown 
below and click Save
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Create the rest of the features and save your map.



Now you will label your point features.  Click on the Label button on the 
right-side toolbar.  The Label Features pane appears.  Make sure that 
Enable Labels is set to on and that Landmark Name is selected as the 
Label Field
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Now you will see your landmarks labelled.  But the labels don’t stand out 
on the map very well.  Let’s change the label properties.
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Click on the Edit Label 
Style drop-down box.
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The Label Style pane opens.  On 
this pane you can edit various 
properties of the labels, including 
the font type, font size, font color, 
the label offset position, the color 
of the halo surrounding the label 
font, and halo line thickness.

Click on the pencil icon next to 
font color.
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Move the cursor around in the 
color field of the Color Selector 
to pick a color that stands out on 
the map.  In the example below a 
bright pink color has been 
selected.

Select a contrasting color for the 
symbol halo.  In the example 
below white has been selected 
for the halo color and the halo 
size has been set to 2.
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Now let’s look at 
some features of 
the web map you 
created.  Go to the 
map and click on 
the Perry-Paige 
building point 
feature.  In the 
popup window 
click on Edit.
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The Edit Feature pane 
appears.  The point feature 
attributes can be edited and 
updated.
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Close the Editor pane by 
clicking on the Edit icon.



Click on the Perry-Paige point feature again and click on Get Directions 
in the Popup window.
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The Route pane opens with 
the selected point set as the 
origin point.  

Plot a route to the FAMU-
FSU College of Engineering.  
Begin typing the address, 
2525 Pottsdamer Street.  As 
you type, ArcGIS will suggest 
addresses that match your 
text.  If you see your desired 
location appear, click on it.

Origin 
Location

Destination 
Location
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The Route pane is populated with 
information on the trip, including 
driving time and directions.  Clicking 
on the Driving Time field allows you to 
select different options, such as 
walking time.
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The route you just created is 
added to the map as a new 
layer.  Open the Layers pane 
and you will see it.  You can 
turn the layer on and off 
with the eye icon.  Expand 
the Route layer options 
menu and examine the 
options.  For example, you 
can show the layer 
properties and edit some of 
its characteristics, launch 
the directions, recalculate 
the route and rename it.  

For this exercise remove the 
Route and save the map.
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The route you just created is added to the map as a new layer.  Open the Layers 
pane and you will see it.  You can turn the layer on and off with the eye icon.  
Expand the Route layer options menu and examine the options.  For example, you 
can show the layer properties and edit some of its characteristics, launch the 
directions, recalculate the route and rename it.  

Remove the Route layer from your map 
and save it.
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Now you are going to create an app from 
your Web Map that anyone can access 
and use.  First you need to apply some 
security settings to the layer so no one 
can change the layer.

Click on the three horizontal lines 
(sometimes called the “hamburger” icon, 
presumably because it resembles a 
hamburger patty between two slices of 
bread).  Click on Content.
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Click on the Layer (NOT the Web Map but the Layer you created and added 
to the Web Map)
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The layer’s overview page opens.  Click on the Settings tab.
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Make sure the Delete Protection and Public Data Collection checkboxes are 
checked.
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Click on Edit Extent
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Search on Florida A&M University.  The map will zoom in to the FAMU campus.  
Click on Draw the Extent on the Map and draw a box on the map that covers the 
entire FAMU campus and a little north of Gaines Street. Click Save.



Return to your Content page.  Now you should see a pencil icon next the Feature 
Layer indicating that the layer is approved for editing by the public.

Click on the Web Map and open it in Map Viewer.



You need to make sure that both the hosted feature layer and the web map are 
shared with the public so that anyone can see the map without having to log in to 
ArcGIS Online.  The world icon indicates that sharing is set to everyone.  In the 
example below the person icon indicates that only you can see the hosted feature 
layer.  To change the sharing level, click on the icon.
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Click on the Everyone 
(public) selection and 
Save.
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Now you are ready to create the app. From the Content page and click on the 
Web Map.

From the Overview page click on Create Web App.
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Select Instant Apps.

Select the Basic App.
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Accept the field defaults.  Click Create App.
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Click through the informational windows and accept the default 
settings.
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Click on Publish 
then click on 
Confirm.
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Set the Sharing Level to Everyone and 
click Save.Under Share click Change Share 

Settings
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Click Launch.

If necessary, click Publish
again.
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Your map should now be visible to everyone who has the link.  They can 
zoom in and out and click on the landmarks to see the photos and attribute 
data.
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Go back to your Content page.  You should see your new map App. The App is 
the mapping application.  The app calls up the hosted feature which is separate 
from the app.  The layer can be edited, and the updates will be incorporated in 
the App map.

Click on the app to open its overview page.
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Scroll down until you see the URL field for your app.  Click on the Copy 
button to copy the URL.  Test the map by logging out of your ArcGIS 
Online account and then paste the URL into a web browser and see if 
you can interact with the map.  If you can’t access it, then go back 
over the sharing steps.  Send the link to a friend and have them test it 
too just to be sure.
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